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Introduction 

The new and improved features and enhancements in KeyShot 6 are distributed in four areas of focus: 

 

● Improved Workflow Efficiency—Lighting Presets, Real-Time Region Rendering, Copy to Scene 

Set, Save Active Scene Set, Multi-Layer PSD, Lock Scene Tree Items, Move Tool Updates. 

● Greater Material Control—Material Graph, Materials on Labels, Material Animation, Occlusion 

Procedural. 

● Amazing New Capabilities—Geometry View, Geometry Editor, Scripting Console, First Person 

View, Shift Lens. 

● Powerful Feature Enhancements—Flexible Import Options, Unlimited Rendering Resolution, 

Pro with Animation, Camera Path Animation, Pivot Point Objects, Zoom Animation, DOF 

Animation, Panorama Camera Animation, Interior KeyShotVR, Preserved Image Quality, 

Responsive KeyShotVR. 

Product Updates 

With KeyShot 6, new product and pricing changes have been made to open up more possibilities for 

users of both KeyShot HD and KeyShot Pro. The following changes are in effect with this release. 

KeyShot HD 

Now includes Unlimited Rendering Resolution 

 

Now every version of KeyShot has unlimited real-

time and output rendering resolution! There are no 

longer any restrictions on resolution. From the 

Project, Image tab select from the resolution 

presets or enter any resolution value with the 

width and height input fields. This comes with no 

additional price increase to KeyShot HD. 

 

KeyShot Pro 

Now includes KeyShot Animation 

 

Every license of KeyShot Pro now includes 

KeyShot Animation! Users of KeyShot Pro can 

now enjoy adding, editing, and rendering all 

animation types. Animation will no longer be 

available as a separate add-on (previously $500) 

and there will be no additional price increase for 

KeyShot Pro.  

If you currently have KeyShot Animation as an add-on, you will be able to use it with KeyShot 6. If you 

wish to purchase KeyShot Animation, you will need to purchase or upgrade to KeyShot 6. Please contact 

Luxion at sales@luxion.com for information on adding KeyShot Animation or about how this may affect 

your current licenses.  

 

 

Compare KeyShot features 

 

http://www.keyshot.com/
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Feature Highlights 

Interior Lighting 

KeyShot now has a new Interior lighting mode that converges faster for complex lighting situations. This 

preset is part of the new Lighting tab in the Project window that contains Lighting Presets. Lighting 

Presets provide pre-configured settings for six different light modes, including: 

 

Performance - This setting disables light source materials and shadows with reduced bounces 

for the fastest performance possible. This is useful for scene setup and quick manipulation. 

 

Basic - This setting provides simple, direct lighting with shadows for basic scenes and fast 

performance. This is useful for rendering simple models illuminated by the environment. 

 

Product - This setting provides direct and indirect lighting with shadows. This is useful for 

products with transparent materials illuminated by the environment and local lighting. 

 

Interior - This setting features direct and indirect lighting with shadows that is optimized for 

interior illumination. This is intended for complex interior illumination with indirect lighting; 

although it can also be used to avoid noise created by local lights and provide more accurate 

sampling of HDRIs with very small and strong light sources such as Sun & Sky. It is also useful 

for:  

○ Jewelry: very fast convergence of caustics 

○ Exteriors: better HDRI sampling (fully spherical) and better handling of very bright, very 

small areas in an HDRI (e.g. Sun & Sky) 

○ Products: Avoiding noise from local lights in glossy materials 

 

Full Simulation - This setting features full simulation of all lighting effects and is intended for 

complex interior illumination with indirect lighting and caustics. Try using this preset when working 

with gemstones and jewelry that requires a higher number of ray bounces and caustics. 

 

Custom - This setting has user-defined settings and the ability to save and load presets. 

 

How it Works 

From the Project window, select the Lighting tab (or access via the Lighting drop-down on the main 

menu). Expand the Settings options and notice how the parameters change with each preset. If a 

parameter is manually adjusted, the preset will switch to Custom, which can be saved by clicking the add 

icon next to the drop-down. After a name is entered, this new custom preset will be added to the drop-

down list where it will be saved. To delete a custom preset, simply select it from the drop-down and click 

the trash icon. 
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Materials on Labels 

Materials and textures can now be applied to labels to enhance appearance and realism. Having this 

flexibility allows for a more accurate communication of labels and their true physical properties.  

 

How it Works 

It is important to understand that materials on labels act as a blended material rather than a layered 

material. This means that a material with transparency (i.e. Xray) will create transparency through the 

parent material as well, not just through the label itself. 

 

When a label has been applied to a material, it will show up in the Labels tab of the material it is applied 

to. The label name now has a prefix based on the material type that is assigned to it. By default, a label 

will be assigned with the Plastic material type and will appear just as it would in KeyShot 5. Selecting a 

label from the list will display material properties, textures, and mapping parameters below. To adjust 

label mapping go to the Label Textures tab, select the diffuse/color texture thumbnail button and use the 

mapping controls found below. To change the label’s material, select a different type from the Label Type 

drop-down. The available Label Properties and Label Textures parameters and options will update 

according to the type selected and behave just as material properties and textures do, with a few small 

differences.  

 

When an opacity map is applied to a label it will behave as an additional mask for the label texture and 

will not affect the blended parent material. If a parent material has a bump map applied and Bump under 

Label Textures is selected, there is now a new option for From Parent under the Texture Type drop-down 

that will allow the bump map that is assigned to the parent material’s texture to be adopted. Alternatively, 

Apply Bump To Labels can be enabled in the parent material Textures tab when Bump is selected to 

apply the parent bump map to all labels assigned to that material. 

 

First Person Mode 

A First Person View (FPV) Camera with support for ground detection now provides a new way to move 

and explore a scene, useful for navigating through interior and architectural scenes.  

 

How it Works 

From the Camera menu select Enter First Person Mode. A heads-up display (HUD) will appear in the 

Real-time view with a legend for mouse controls, a value entry field for Eye height displayed in scene 

units, an option to Lock Eye Height, and an option to enable Collision Detection. The following mouse 

buttons control motion: 

 

Left Mouse Button (LMB) - Rotate 

Middle Mouse Button (MMB) - Pan 

Right Mouse Button (RMB) - Move 

Alt+RMB - Move to Position 
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Activating Collision Detection will provide a realistic walkthrough that moves the camera up and down 

stairs, ramps, and other changes in elevation by calculating camera height to maintain a constant 

distance to the object currently under the camera. When the green check is selected, a new First Person 

Camera will be saved in the Camera list in the Camera tab. 

 

Shift Lens 

KeyShot 6 now has a new Shift Lens setting with an Estimate Vertical Shift function that allows the 

verticals in a scene to be aligned with the click of a button, which is particularly useful in eliminating 

convergence of vertical lines for architectural shots (interior and exterior). Especially so for tall buildings, 

visualized from ground level. 

 

How it Works 

From the Project window, select the Camera tab and navigate to the Lens Settings section that contains 

the new option for Shift with settings for Vertical Shift and Horizontal Shift, as well as a button to Estimate 

Vertical Shift. Selecting Estimate Vertical Shift will use the current camera Inclination value to estimate 

the appropriate vertical shift value to align the verticals in a scene. For best results, locate the camera at 

desired height and then adjust the shift accordingly to frame the subject. 

 

 

Lock Scene Tree Items 

In addition to Cameras, there is now the ability to lock models, parts, and animations in the Scene Tree to 

prevent them from being modified.  

 

How it Works 

From the Project window, open the Scene tab. Right click on a model, part, animation, or camera and 

select Lock, which will display a lock icon in the rightmost column and gray out the respective show/hide 

checkbox. The right-click menu for models and parts provides an additional option to Hide and Lock, 

which will automatically hide the model or part and subsequently gray out the name indicating its state. To 

unlock an item simply right click and select Unlock.  

 

There are different benefits to locking an item depending on the type: 

 

Locking a top-level Model - This will subsequently lock all contained parts and animations to 

prevent the model and contained parts from being hidden/shown or transformed, Render Layers 

from being changed, Rounded Edges from being adjusted, and materials from being unlinked and 

edited to an extent. Material changes are prevented when dragging and dropping a material from 

the Library onto a model or part in the Scene Tree or Real-time view; however, a material can still 

be edited by double clicking on it in the Scene Tree or Real-time view. If a locked part shares a 

linked material with an unlocked part, the unlocked part’s material will automatically become 

unlinked when it is assigned by drag-and-drop. 
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Locking a Part - This will prevent all the same changes as models; however, the main benefit is 

that a hidden and locked part will remember its hidden state when its model level is hidden or 

shown.  

 

Locking an Animation - This will prevent all properties from being modified and will therefore 

show a grayed-out properties dialog in the Animation Timeline. 

 

Move Tool Updates 

The Move Tool has now been improved with an easier-to-use widget along with the ability to pick a 

rotation Pivot, Snap to Pivot and Snap to Lower Object. The Move widget has been updated by flipping 

the direction of the scale handles and extending the translate arrows outside of the rotation handles, 

which now have gaps at the intersection points to reduce the likelihood of unintended actions. 

 

How it Works 

Open the Move Tool just as before and notice changes to the dialog including check boxes that 

enable/disable the Translate, Rotate, and Scale widgets. The Pivot option allows a pivot point to be set 

for rotation; simply click Pick to launch the Pivot Selection dialog. Select the desired part in the dialog or 

directly in the Real-time view and select Ok or Done to update the position of the Move widget. The Snap 

to Pivot option will automatically move the center of the model or part to the center of the Pivot. The Snap 

to Lower Object option will automatically move the bottom edge of the object’s bounding box to the top 

edge of the bounding box of the part located below. Keep in mind that since the bounding box is what’s 

being referenced, the results may not always be perfect. This feature works best when the two surfaces 

being snapped are parallel to each other. 

 

New Material Presets and Favorites 

KeyShot 6 comes with additional material presets and industry focused favorites to make scene setup 

even faster. A new Glass>Window folder contains pre-configured window materials for a range of glass 

types and appearances. Three new Favorites are available that provide a collection of materials, 

environments, colors, textures and backplates for Architectural, Jewelry and KeyShot Favorites. 

 

How it Works 

To use the new Window materials, go to the Library, Material tab and expand the Glass folder. Select the 

Window folder, then drag and drop a material onto a model. Alternatively, search for ‘window’ in the 

Material tab search bar to see a selection of window materials. 

 

To view the new Favorites, in the Library window, select the Favorites tab. Three resource collections will 

appear in the pane and may be expanded to view the materials, environments, colors, textures and 

backplates within each. Favorites are stored in uniquely generated .xml files stored in the KeyShot 

Resources folder. New materials, environment and other resources may be added to a favorite by right-

clicking on the resource and selecting Add to Favorite, then choosing an existing favorite or creating a 

new one.  
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New Material Types 

New material types have been added to KeyShot to provide more control over material properties and 

achieve more accurate results. The Material Types drop-down on the Material tab is now split into Basic, 

Advanced, Light Sources and Special material types. Advanced material types contain more settings for 

greater control over the material. New Material types include: 

 

Translucent (Advanced) - The new Translucent (Advanced) material type supports more texture 

channels than the Basic Translucent, including Surface Color, Subsurface Color, and 

Translucency. In addition, this new Translucent material now supports the projection of caustics 

for cases such as a translucent eyeball with a glass lens. This material behaved best when the 

object it is applied to is a single mesh body. Objects with multiple intersecting meshes work best 

with the Basic Translucent material. 

 

Plastic - The new Plastic material type is a simplified opaque plastic that does not have control of 

transparency parameters. 

 

Dielectric - The improved Dielectric material type has been optimized to better separate colors of 

the spectrum for a more accurate appearance of Dispersion. 

 

Gem - The improved Gem material type has also been optimized to better separate colors of the 

spectrum for a more accurate appearance of Dispersion. 

 

 

How it Works 

Double-click on a part in your scene to edit it’s material. The material properties of the part will appear in 

the Project window. In the Material Type section, select a new material from the Material Type drop-down. 

The color of the part will be retained, but the properties will update to match that of the specific type of 

material. Adjust the settings as needed. Settings with arrows on the left designate settings that can be 

expanded to show additional options. 

 

Material Type Updates 

Certain materials in KeyShot now have more parameters: 

 

Toon - There are three new parameters added to the Toon material in KeyShot 6.1. These parameters 

are found in the Advanced drop-down and allow for greater contour control. The Outline Width Multiplier 

and Part Width Multiplier allow for independent width control so one can be thicker than the other. The 

Part Contour checkbox allows for coplanar parts to be defined by a contour. 
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Anisotropic - When using the Radial mode there is now a Position widget that allows you to define the 

desired location of the radial roughness by clicking on the model. 

 

Occlusion Procedural 

This new procedural texture type allows for the addition of proximity-based shading on a material. It can 

be used to accentuate or augment the self shadows cast on a material and, along with the Material 

Graph, to create interesting texture effects based on occluded and unoccluded areas. 

 

How it Works 

From the Project window, open the Material tab. Select the Textures tab and the Diffuse texture thumbnail 

button. From the Texture Type drop-down, select Occlusion under the 3D Textures header. Hover over a 

parameter to view its description. 

 

Flexible Import Options 

For certain file types, KeyShot users have more flexible import options, including the removal of Size 

options with scene units automatically matched with the imported model. KeyShot Import also features 

new Materials and Structure options, including Group by Material and Separate Parts by Material. 

 

How it Works 

From the File menu, select Import… to bring up the Import file dialog. Select the file to import and select 

Open. Depending on the file type, you will see new options for Materials and Structure. The following new 

options are available: 

 

Group by Object - Using this option will maintain hierarchy and model structure 

 

Group by Material - Using this option will ignore model structure and flatten hierarchy. Multiple 

objects with shared appearances or shaders applied in CAD will be combined into a single object. 

 

Separate Parts by Material - This option will prepend material names with their respective part 

name. Using this option with Group by Material will only combine objects with shared 

appearances or shaders within each part, rather than the entire assembly. Using this option with 

Group by Material will have no effect on hierarchy. 

 

Material Graph (Pro) 

Material editing is now more robust than ever before with the KeyShot 6 Material Graph. The Material 

Graph opens in a separate window and displays materials, textures, labels and more as nodes in a graph 

view to visualize connections and relationships within complex materials.  

 

How it Works 
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The Material Graph can be accessed through the Project window Material tab by KeyShot Pro users only. 

Click the Material Graph button at the top of the dialog to launch the Material Graph window. There are 

five components of the Material Graph window: menu bar, Ribbon, Materials & Textures Library, Material 

Properties, and the Work Area. 

 

Menu Bar - The Material menu gives the option to create a New material; this will replace the 

working material and any textures with a basic diffuse material to start from scratch. Import allows 

the import of .mtl files created with KeyShot. Another way of importing is to simply drag and drop 

a material or texture directly from the KeyShot Library. Save to Library will save the working 

material to a specified folder in the KeyShot Library. Export will save an .mtl file to the specified 

location. The Nodes menu provides quick addition of Material, Texture, Animation, and Utility 

nodes to the work area. The View menu provides the Align Nodes command, which automatically 

arranges connected nodes in the work area, the Zoom to Fit, Zoom to 100%, and texture map 

preview options. A single node must be selected for the preview options to be available. The 

Window menu gives access to hide/show the Ribbon, Material Properties window and Materials & 

Textures library. 

 

Ribbon - The Ribbon provides even quicker access to the same functions found in the menu bar 

with the addition of Duplicate and Delete selected nodes. The quick-access node action icons 

include default nodes for each category. The Material icon adds an Advanced Material node. The 

Texture icon adds a traditional texture map and opens the file browser window to select an image 

file. The Animation icon adds a Color Fade node. The Utility icon adds a Bump Add node. 

Additional buttons allow quick access for previewing texture maps and automatically arranging 

nodes. 

 

Materials & Textures Library - The Materials & Textures library contains an organized thumbnail 

display of all the same nodes found in the Nodes menu and the Work Area right-click menu. 

 

Material Properties - The Material Properties dialog shows the associated properties for the 

current node being edited. Double-clicking on a node, allows quick access to its Material 

Properties. While the settings for each material are the same as what you see in the Materials tab 

of the Project window, root and parent nodes will take on the properties of their child nodes. All 

textures will be synced with their siblings unless Sync is unchecked from the Material Properties 

of the texture.  

 

Work Area - The Work Area displays all nodes and connectors of materials, textures, labels, 

material animations and utilities. Right click in the work area for access to the same nodes as 

those found in the Nodes menu. Select a node by left clicking. Select multiple nodes by left 

clicking and holding Ctrl (CMD on Mac). Use the marquee selection to select a group of nodes by 

holding Shift while clicking and dragging. Right click on a selection of nodes to duplicate, delete, 

disable, cut or copy that selection. Zoom in or out of the Work Area using the middle mouse 

wheel and pan using the left mouse button. 

 

Nodes - Nodes are displayed as graphic boxes in the Work Area. Each node has different input 

and output channels depending on the type.  
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Utility Nodes - There are several utility nodes that can be used to create a rich variety of effects.  

 

○ General purpose: Modify existing nodes. 

○ Bump Add - This node allows for the combination of two bump maps. 

○ Color To Number - This node can, for example, be used to remap the range of a ‘Color 

Fade’ animation. It can also be used to remap a texture image to a roughness values 

between specific values, e.g. 0.05 to 0.10, or anything where precise numerical values 

are needed.  

○ Color Adjust - This node modifies another textures color, i.e. it can be used to shift the 

hue, saturation, value, contrast and blend with another color. All of these can be textures, 

i.e. you can use a Noise texture to modify the saturation of another texture. This can be 

useful for color studies. 

○ Color Composite - This node is equivalent to having two layers in photoshop. The 

blending modes should behave exactly the same as in Photoshop. 

○ Color Invert - This node inverts the color, for example, it will change black to white. This 

can be useful for masks/opacity maps. 

○ Color Key Mask - This node can be used to key out a specific color of the source node. 

This is almost always used as alpha/mask/opacity. It can also be used in packaging 

design to apply different materials, textures, colors, etc. to specific (solid color) areas of a 

single image label. 

○ Curve Color Randomize - This node only works with curve geometry. It applies a 

random color modification based on individual curves. It’s very useful to create additional 

detail without using a texture map. Note: The Color Gradient texture has a “Curve” 

gradient type which applies a gradient along each curve for curve geometry. 

  

Animation Nodes - There are two Animation modes that can be used to change color or 

settings. 

 

○ Number fade - This node is used when more precise control of the numerical value is 

needed, or if the value needs to go below zero or above one. Examples include: light 

multipliers, roughness, bump height, procedural texture parameters (use it to animate 

Cellular shape for example).  

○ Color fade - This node can be used for fading between multiple colors. A sharp transition 

can be achieved by placing two gradient stops very close to each other.  

 

 

Connections - Channel connections are made by clicking on an output channel and dragging 

and releasing directly onto an input channel or onto the node itself. When it is released onto the 

node, a context menu will show all the available channel options. When a connection is selected, 

a dashed box will surround it; right click to remove or disable the connection. A disabled 

connection will be displayed as a dashed line. 

 

Previewing Texture Maps - To preview the color, alpha or bump of a texture map in the Real-

time window, first select the Texture Node in the Material Graph. Next select Preview Color, 

http://www.keyshot.com/


 

KeyShot 6 What’s New Guide | 2.0 

 

 

 

Luxion, Inc. • 15143 Woodlawn Ave., Tustin, CA • Phone +1 949.274.8871 • http://www.keyshot.com 

Preview Alpha, or Preview Bump from the Material Graph, Ribbon bar. To remove the preview, 

click the ribbon button again. You can also use the hotkeys “A” for Preview Alpha, “B” for Preview 

Bump, and “C” for Preview Color. 

 

 

 

Scripting Console (Pro) 

A wide range of KeyShot functionality is made available via scripting to unleash the power of automation 

and batch processing. Predefined scripts are found in the Scripts tab of the Scripting window, which 

includes easy-to-use scripts for batch rendering, encoding video and more, with complete functionality to 

create and save custom scripts. This includes camera control, lighting presets, materials and material 

templates, environment, background, backplates, rendering (images, animations, and VR) and 

opening/saving/importing files. 

 

How it Works 

Scripting in KeyShot Pro is implemented using Python 3.4 and is accessed via the Scripting Console 

(Window , Scripting Console) or from the Ribbon bar below the main menu. If the Ribbon is not visible go 

to, Window, Show Ribbon or press the ‘R’ key. Scripts are loaded using the Scripting, Console command 

line, using the format keyshot -script <path to script> <optional script arguments, 

..>. Online scripting documentation is located at https://keyshot.com/scripting/doc/6.0/ which also 

contains a quick start guide on how to use scripting. 

 

Scripts are located in the KeyShot Assets Folder, e.g. <install path>\KeyShot 6\Scripts. To change this 

location, select Edit, Preferences, Folders and change the path for the Scripts folder. Scripts in the folder 

will be visible in the Scripts tab of the Scripting window. Two examples scripts include: 

 

Render Images 

Renders obj or geometry sequence into images. Renders a frame for each geometry file. 

 

How to use: 

● Select script and press Run, which shows a dialog asking for input. 

● Click the browse button and select the folder with the geometry (.obj) sequence. 

● For input, type the extension of the geometry without the dot (obj). 

● For output, type the extension of the image format without the dot (png). 

● Input the width and height of the output images in pixels. 

● Click OK to begin the process. 

 

Encode Video 

Encodes video using an image sequence over a specific range of frames. 

 

How to use: 

● Select script and press Run, which shows a dialog asking for input. 

● Click the browse button and select a folder with the image frames. 
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● For frame format, copy the name of the file, replacing the frame number with %d, e.g. 

my_new_animation.%d.jpg. 

● Enter the start frame - the number in the name of the first image, e.g. 1 on 

my_new_animation.0001.jpg. 

● Enter the end frame - the number in the name of the last image, e.g. 60 on 

my_new_animation.0060.jpg. 

● Enter FPS for the video. 

● Enter the video name. 

● Click OK to begin the process. 

 

Vector and matrix classes are made available in the luxmath module to help with doing calculations. 

They are named luxmath.Vector and luxmath.Matrix respectively. For more information on this, 

please see https://keyshot.com/scripting/doc/6.0/luxmath.html 

 

Creating a Script 

To create a script, select Create from the Scripts tab. Provide a name for the script and the author. 

If Python 3.4 is installed locally on the machine, then KeyShot will detect Python and all of the installed 

modules, such as NumPy, SciPy, PIL, etc., that can then be freely used for scripting in KeyShot (this can 

be disabled in the advanced preferences section). You may also import a script or edit an existing script 

using the corresponding buttons on the Scripts tab. 

 

Example use cases of scripting: 

 

● Render and encode a fluid simulation of images to video. 

● Batch process multiple files, like applying materials, environments, backplates, camera 

information etc., and render results to images, VR or video files. 

● Automate workflow by using the -script CLI argument when starting up KeyShot for setting up 

default values and settings. 

● Add more! 

 

Scripting Resources 

● Scripting sub-forum: https://www.keyshot.com/forum/index.php?board=67.0 

● Online docs: https://keyshot.com/scripting/doc/6.0/ 

● Online quick-start: https://keyshot.com/scripting/doc/6.0/quickstart.html 

● Learning Python: 

○ http://www.learnpython.org 

○ http://www.diveintopython3.net 

 

 

Geometry View (Pro) 

KeyShot 6 now introduces an entirely new way to setup a scene by using the Geometry View window. 

This highly responsive secondary display of the Real-time view makes working in KeyShot even faster 

and more efficient than before. Some benefits of the Geometry View are as follows: 
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● Animations can be played back at a true 1:1 speed. 

● A secondary camera can be used for easier positioning of physical lights in a scene. 

● Scene transformations and composition setup are faster. 

● Control of Camera Path Animations. 

 

How it Works 

From the Window menu select Show Geometry View or simply press the ‘O’ key. This window can be left 

floating, or it can be docked on the left or right side of the Real-time view.  

 

The Geometry View Ribbon provides access to options to adjust the viewport. Select the desired Display 

Style options of Shaded, Flat, Shaded Wireframe, Wireframe, or Bounding Box.  Choose a camera from 

the Camera drop-down from these available options—Active, Perspective, or Orthographic. From the 

ribbon, select a Display Orientation option of Front, Back, Left, Right, Top, or Bottom.  The display of 

Ground Grid, Lights, Camera Paths, Pivots, and Camera Fov can be enabled by checking the respective 

box within the Geometry View Settings window. To change the background color click on the color swatch 

in the settings window. Enter the Geometry Editor by selecting a part with the Scene Tree open and 

clicking the Edit Geometry button. 

 

A benefit of the Geometry View is the visualization of cameras. Cameras are identified by a cubed shape 

model while Viewsets are identified by a sphere shaped model. The respective names are always shown 

for each camera and Viewset. When a camera or Viewset is selected it’s field of view is shown as a 

wireframe projection. 

 

Geometry Editor (Pro) 

A new Geometry Editor brings the freedom of splitting surfaces, calculating vertex normals, separating 

individual surfaces and closing open boundaries directly inside of the KeyShot through an integrated 

Geometry View.  

 

How it Works 

Right click on a part in the Scene Tree or Real-time view and select Edit Geometry to launch the 

Geometry View and the Geometry Editor dialog. Tools in the Splitting tab allow for splitting bodies, 

separating individual surfaces, and merging. Tools in the Normals tab allow for evaluating vertex and face 

normals and for calculating vertex normals based on angle. Tools in the Closing tab allow for calculating, 

closing, and connecting boundary edges. 

 

● Split Object Surfaces 

○ Polygons - Selects individual triangles. Ctrl + click to multi-select or shift+drag to 

marquee select. 

○ Splitting angle - Select connected triangles where the angle between adjacent triangles 

is less than x degrees. 

● Split Separate Objects 
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○ Splits disconnected parts into sub parts. Useful for splitting objects that are imported as 

one objects. 

● Edit Normals 

○ This is similar to calculating the normals on import. The difference is that it can be done 

on specific parts instead of the entire model. There is also the option to set a smoothing 

angle to maintain sharp edges. 

● Close Mesh 

○ This option can be used to close holes in the mesh. Some materials require a closed 

mesh to work correctly, solid glass for example. 

 

HDRI Editor (Pro) 

New updates with KeyShot 6.1 bring new half pins, numerical control of pin location, and performance 

improvements. Half Pins provide the benefit of a very sharp falloff on the edge being halved and full falloff 

control for the rest of the pin. Pin location can be controlled by the Azumith and Polar sliders. 

Performance improvements include faster manipulation, faster generation of high resolution images, and 

faster saving. 

 

How it Works 

Both circular and rectangular pins can be converted to Half Pins by checking the box labeled Half in the 

HDRI Editor Adjustments panel. 

 

Pin location is now identified by Azimuth and Polar sliders. These sliders update accordingly when pins 

are manually dragged in the image. Azumith controls the horizontal rotation while Polar controls the 

vertical rotation. 

 

Multi-layer PSD (Pro) 

When outputting rendered still images and Animation frames as PSD and PSD 32 Bit format, Render 

Passes and Render Layers will be included as individual layers contained in the Photoshop file. 

 

How it Works 

In the Render dialog, select Output from the sidebar. Select PSD or PSD 32 bit from the format selector 

drop-down. Enable Passes and/or Layers and check the Add to PSD box. When the file is opened in 

Photoshop, all passes and layers will be included. 

 

Copy to Scene Set (Pro) 

KeyShot 6 now provides the option to copy models and parts from one scene set to another. 

 

How it Works 
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In the Project window Scene tree right-click on a part or model and select Copy to Scene Set. In the flyout 

menu chose to copy to the default Scene Set or any other existing Scene Set other than the one that is 

currently active. This will copy the selected object so it exists in both Scene Sets. Keep in mind that the 

materials will not be linked on the object that is copied. 

 

 

Save Active Scene Set (Pro) 

The ability to save active Scene Sets allows them to be easily shared with users of KeyShot HD who do 

not have direct access to Scene Sets in a scene created with KeyShot Pro. 

 

How it Works 

Right-click the Scene Set you wish to share and select Make Scene Set Active, if not active already. From 

the File menu, select Save Active Scene Set... to launch the Save As dialog. This will save the active 

Scene Set as a separate .bip file. If the file is intended to be shared it is important to remember to save it 

as a KeyShot Package file (.ksp) so all scene assets are included. To do this the newly created .bip must 

be opened separately then saved as a .ksp. 

 

Real-time Region Rendering (Pro) 

KeyShot Pro users can now render any region of their scene in real-time. Only the region enclosed by the 

bounding box in the Real-time view will be rendered. This can greatly improve workflow efficiency when 

working with resource intensive scenes, as processing power is not wasted rendering areas outside of the 

region bounds. Use this feature while dialing in materials to see the areas res up faster than if displaying 

the entire Real-time view.  

 

How it Works 

From the Project window select the Image tab to find the Region section. Check the box to enable and 

resize the region bounds using the input values or by dragging the handles in the Real-time view. When 

Region is enabled in the Image tab, it is synced with the Region option in the Render Output dialog. 

Taking a Screenshot when Region is enabled will only output the area enclosed by the Region, with the 

rest of the image shown as a solid black color for easy selection and cropping in Photoshop. 

 

Material Animation (Pro) 

Color Fade and Number Fade animations now make it possible to quickly adjust material colors or 

settings, change materials opacity or fade lights, through the new Material Graph, eliminating the need to 

blend frames in post-production. 

 

How it Works 

Contained in the Material Graph, Materials & Textures library is the Animation folder that contains the 

Color Fade node and Number Fade node. These nodes can be used to animate the properties of the 
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material being edited in the Material Graph. Simply make a connection from the animation node’s output 

channel to the desired material or texture node’s input channel. (Learn more about the Material Graph.) 

Each animation that is added through the Material Graph will show up in the Animation, Timeline with its 

properties shown on the right-hand side when selected. Material properties that have animations applied 

to them will display an animation icon next to the disabled textbox. To enable this, remove the connector 

applied to the property in the Material Graph. 

 

Color Fade 

Animate a material or material texture map between two color, across a range of colors or change 

a material’s opacity over a specific duration.  

 

How it Works 

The Color Fade animation may be applied to a material from the Material Graph or to a texture 

from the Material, Textures tab as a Texture Type on a Color, Specular or Opacity map.  

 

In the Material Graph, double-click or drag and drop the Color Fade animation to the work area. 

Select the Color Fade input connector and drag it to a material’s input connector. Double-click on 

the Color Fade node to see and adjust its setting in the Materials Properties, Properties tab.  

 

In the Texture tab, double-click a material and select the Textures tab. Select the map to fade, 

then select Color Fade from the Texture Type drop-down menu. Double-click the color bar to add 

a new pin and double-click the pins to change the color. Set the Start, End, Duration and Motion 

ease under the Time Settings. The animation can be seen in the Animation Timeline. Adjust it as 

any other animation. Select Play to see the color fade animation.  

 

Number Fade 

Animate material or materials texture properties across a min and max range for a specific 

duration. 

 

How it Works 

In the Material Graph, double-click or drag and drop the Number Fade animation to the work 

area. Select the Number Fade input connector and drag it to a material’s input connector. Double-

click on the Number Fade node to see and adjust its setting in the Materials Properties, 

Properties tab.  

 

Camera Path Animation (Pro) 

KeyShot 6 opens up the ability to create incredibly dynamic camera motion with the new Camera Path 

Animation. With more control over the camera, smooth path-driven animations can be added in just a few 

clicks.  

 

How it Works 

Adjust the Real-time Viewer to the desired view for the camera starting point. From the Project window, 

navigate to the Scene tab. The Scene Tree contains the list of saved cameras. Right click on a saved 
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camera and select Path to start creating the animation. The Camera Path dialogue box will appear with 

the first camera position shown. Change the view and click the + above the camera position list. Continue 

to adjust the view and add points. Don’t worry, you can update the path and camera location after the 

animation has been created. Hit OK. The camera path animation will be visible in the Animation Timeline.  

 

To view and edit the camera path, open the Geometry View icon from the Ribbon or select Window, 

Show Geometry View. The cameras (Control Points) and camera path will be visible. Left-click to select a 

camera. Right-click to show options to move, add or delete a Control Point. 

 

To move a Control Point, select a Camera, right-click and select Move Control Point. The Real-time 

Viewer will move to that Camera position. Zoom out slightly to see the Move Tool and adjust the Camera 

as needed. When finished, select the green check. 

 

Pivot Point Object Axis (Pro) 

The Rotation Animation feature now provides the ability to use the Pivot Point object's local axis, allowing 

for greater flexibility and more dynamic rotations. 

 

How it Works 

When a Rotation Animation has been added to a scene, select it in the Animation Timeline to view its 

properties. Just as before, a custom Pivot Point can be picked in the Pivot Point options. To use the local 

axis of a custom Pivot Point, simply enable Pivot Point Object Axis and select Original Local for the Axis 

Orientation under the Rotation options. 

 

Depth of Field Animation (Pro) 

The new Depth of Field Camera Animation allows for the dynamic change of the camera’s focus distance 

and F-stop values.  

 

How it Works 

From the Project window, navigate to the Scene tab. The Scene Tree contains the list of saved cameras. 

Right click on a saved camera and select Depth of Field to add the animation. Select where you want the 

focus to begin with the From Focus Distance slider or choose Select “Point of Focus” to pick a starting 

point. Select where you want the focus to end with the To Focus Distance slider or choose Select “Point 

of Focus” to pick an end point.  

 

Note: Adding this animation will enable the Depth of Field option under the Project, Camera, Lens Effects 

and saved with the camera being animated. The values entered in the Depth of Field Animation 

properties will also override the Depth of Field value under Lens Effects.  
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Zoom Animation (Pro) 

The new Zoom Camera Animation allows for the dynamic change of the camera’s field of view. 

 

How it Works 

From the Project window, navigate to the Scene tab. The Scene Tree contains the list of saved cameras. 

Right click on a saved camera and select Zoom to animate.  Select where you want the zoom to begin 

with the From Field of View slider. Select where you want the zoom to end with the To Field of View 

slider.  

 

Note: Adding this animation will override the Field of View setting under the Project, Camera, Lens 

Settings. 

 

Panorama Camera Animation (Pro) 

The new Panorama Camera Animation allows the creation of first-person, rotation animations using the 

camera itself as the rotation pivot. 

 

How it Works 

From the Project window, navigate to the Scene tab. The Scene Tree contains the list of saved cameras. 

Right click on any saved camera and select Panorama to add an animation to the Timeline. Simply set 

the desired degrees of rotation to control the Panorama. Use a positive value for left-to-right rotations and 

a negative value for right-to-left rotations. 

 

Interior KeyShotVR (VR) 

The new Interior KeyShotVR is essentially a “look-around” KeyShotVR that uses the camera itself as the 

rotation center. With this feature, in addition to the option to control Horizontal Environment Rotation, 

dynamic interior and look-around KeyShotVRs can be created to help visualize what a space feels like in 

first person. 

 

How it Works 

In the KeyShotVR Wizard or the KeyShotVR Render dialog, is the option to Pick KeyShotVR Rotation 

Center. Use Camera as the rotation center to enable the Interior KeyShotVR. Depending on the desired 

outcome, Horizontal Environment Rotation may also be enabled from the same dialog page. If the 

background is set to Lighting Environment, the Horizontal Environment Rotation should be enabled for 

the most realistic effect. 
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Preserved Image Quality (VR) 

If zoom-in is enabled, the image quality will be preserved when zooming in by enlarging the rendered 

frame resolution accordingly. This is separate from the viewport resolution setting for each frame. 

 

Responsive KeyShotVR (VR) 

A KeyShotVR is now responsive by default with improved embed capability. With this, the KeyShotVR 

automatically resizes to fit browser width. 

 

How it works 

After generating a KeyShotVR, the browser will open, showing the KeyShotVR with instructions for use 

on a website. After the KeyShotVR is uploaded to a website, it may be embedded on a webpage. To 

embed the VR, simply copy and paste the code provided into the html of the webpage. Ensure that the url 

in the iframe tag matches the location of the KeyShotVR file. 

 

KeyShot Connection for Onshape 

KeyShot 6.1 features build-in Onshape integration. For more information, visit keyshot.com/onshape/. 

 

How it Works 

Open KeyShot and select “Connect to Onshape” from the File menu. Once connected to your Onshape 

account, browse and search through public or private Documents and Workspaces. Select a Part Studio 

or Assembly that you want to render, adjust tessellation quality and import it directly into KeyShot. The 

model structure, part and assembly names will all be maintained. With KeyShot Pro, you can even import 

NURBS data for perfectly smooth, rounded surfaces. Then, simply drag and drop KeyShot’s scientifically 

accurate materials and HDRI lighting to make your models look stunning within minutes.  

 

Once done with your work in KeyShot, save and upload your scene directly to an Onshape Document for 

others in your team to make updates. When a change to the design occurs, select “Connect to Onshape” 

again to easily update the model in your KeyShot scene. All of your work inside KeyShot will be 

preserved – materials, lighting, cameras and animations – with all model updates intact. Finish your 

changes and save the scene to Onshape, to ensure everything is up-to-date throughout the entire design 

process.  
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Additional Features 

Additional KeyShot 6.0 features 

 

  

Redo function—The Redo function is located in the Edit menu or may be activated with Ctrl+Y on 

Windows or Command+Y on Mac. 

 

Save Reminder Notification - In Preferences, General, set a Save Reminder notification to display after 

a specified amount of time. 

 

LiveLinking Improvements - Models that are linked to the 3D modeling software through LiveLinking 

now updates Instances, i.e. Patterns, and Scene Sets. 

 

New PANTONE Colors - Updated PANTONE color library to include the new PANTONE+ Extended 

Gamut Coated. 

 

Comprehensive Tool Tips - Hover over a function or parameter to view that item’s description. 

 

Add Camera/Viewset Buttons on Ribbon - Add Cameras and Viewsets directly from the Ribbon. 

 

Normal Projection for Textures - Use Normal Projection as the assigned mapping type for textures. 

 

Opacity Mapping Improvements -  When an Opacity map is applied to a material, the Opacity Map 

Mode selector is activated in Material Properties under Texture & Label Control. Options for Alpha, Color 

(darker colors are more transparent) or Inverse Color (lighter colors are more transparent) are available. 

 

Cylindrical Mapping Improvements - Cylindrical maps now have the one-click option to fit X,Y,Z. 

 

Updated Render Dialog - The Render dialog now has a more efficient organization of items. The sidebar 

contains three items: Output, Options, and Queue. 

 

Resolution Presets - In the Project, Image tab, under Resolution, Presets drop-down, new Portrait 

resolution presets are available with the ability to create Custom resolutions. 

 

Scene Tree Filter and Search - From the Project, Scene tab, use the Show drop-down menu to filter 

what’s being displayed in the Scene Tree. Choose from the options to display All, Parts only, Lights only, 

Animations only, and Render Layers only. This selection controls what is being filtered by the Search bar. 

Click the Search drop-down icon in the Search bar to see available options. 

 

Vignetting Color - Color selection is now available for Vignetting. From the Project window, select the 

Image tab to find the Effects accordion. Check the box to enable Effects to enable vignetting. Increase 

Vignetting Strength to the desired value. Click the Vignetting Color swatch to open the Color Selection 

dialog. Vignetting color is also available in the Render output window in the Effects accordion of the 

Adjustments panel.  
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Edit Label - Right-click on a label in the Real-time view and select Edit Label to display the 

corresponding label properties. 

 

Material List View - New list view mode in the Project, Material tab, below the Materials palette, shows 

all project materials in a list, sortable by name and type. 

 

Material Node View - New hierarchical view mode in the Project, Material tab, below the Materials 

palette, shows and provides quick access to nodes added through the Material Graph. 

 

Project Materials Filter - The Project, Materials tab which displays all scene materials at the bottom, can 

now be filtered By Scene Set or By Visibility. 

 

Save a Viewset with each screenshot - A new checkbox in Edit, Preferences under General, 

Screenshot options to Save a Viewset with each screenshot is available. 

 

IES Light Improvements - An IES light profile preset will now be set automatically when the Point Light 

IES Profile material type is selected, instead of requiring selection of an IES profile. Additionally, there are 

now more IES lights included in the Library. 

 

New Light Thumbnails - With KeyShot 6.1, Library preset thumbnails for IES, Point and Area lights have 

been updated to provide a more accurate preview of brightness and color. 

 

Lux Power Control - In addition to Watt and Lumen, there is now an option to control the Lux of an Area 

Light Diffuse or Point Light Diffuse material by selecting Lux from the Power dropdown. Lux is the 

measurement of Lumen per unit area. 

 

Real-Time Render Time and Samples - The Heads-up Display now shows how long the Real-time view 

has been rendering and how many samples it has used. 

 

SOLIDWORKS Import - A new importer for SOLIDWORKS files including SOLIDWORKS 2016 files that 

allows the setting the tessellation and retrieving the NURBS geometry. Mesh geometry import remains 

available as a Cached geometry checkbox option in the Import dialog. Bodies are also recognized and 

the option to separate materials by part is now possible. 

 

PTC Creo Import - The PTC Creo plugin has been updated to improve tessellation and allows the option 

to separate materials by part. 

 

SketchUp Import - Import for SketchUp 2016 is supported with secure downloads available through the 

SketchUp Extension Warehouse and on keyshot.com. 

 

ZPR Import - In addition to export, import of the 3D Systems ZPrinter (formerly ZCorp) .ZPR format is 

now supported. 

 

PVZ Import - PTC Creo View import is now supported, along with import of .pvs, .ol, .ed, .edz and .c3di. 
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Motion Blur updates - Motion Blur is now available for cameras in both real-time and offline rendering 

mode. Enable through the Motion Blur icon submenu. 

 

Add Scene Sets to Render Queue (Pro)  - In the Render dialog select Queue from the sidebar. There is 

now a button for Add Scene Sets that opens a dialog allowing the selection of one or more Scene Sets to 

be added to the Queue for processing. 

 

Compression for .HDZ files (Pro) - .HDZ files saved from the HDRI Editor are now smaller in file size. 

 

Select Parts by Animation (Pro) - Right click on an animation in the timeline to Select Groups/Parts by 

Animation in the Scene Tree. 

 

GUI License Manager for Mac (Pro Floating) - Easily setup and manage KeyShot Floating Licenses on 

Mac OS X through a configurator. 

 

Network Rendering Email Notification Service (NR) - This will inform the customer about expiring 

licenses (2 months before, 1 month before, and once a day during the last 2 weeks), and when a job has 

finished or failed. If any error occurs the admin will get an email notification. 

 

Automatic Database Migration (NR)  - The Configuration Wizard and Master program will automatically 

migrate the database to the newest version if needed (such as when moving from v4 or v5 to v6). 

 

Notes on User Interface Changes 

● The Scene tab adds an additional filter drop-down for Parts, Lights, Animations and Render Layers. 

● In the Scene tab, text searches now filter for matches in both Parts and Materials column by default. 

● In the Material tab, the Save to Library button has been renamed to Add to Library. 

● In the Material tab, the Material Type drop-down has been split into Basic, Advanced, Light Sources 

and Special material types. Advanced material types contain more settings for greater control over 

the material. 

● In the Environment tab, the HDRI Editor is now accessed by a separate button below the 

Environment preview area. 

● A Lighting menu and Lighting tab have been added between Environment and Camera. 

● In the Camera tab, Add new camera and Add new viewset have been changed from a drop-down 

menu to two separate buttons with Add Camera and Add Viewset also added to the Ribbon menu. 

● In the Camera tab, View Orientation has been renamed to Standard Views. Standard Views 

keyboard shortcuts are available with Ctrl + Alt + 1-7. 

● On the Ribbon, the Camera and Scene Set buttons are now dropdowns that contain a list of saved 

Cameras and Scene Sets.  

● The Settings menu and Settings tab is now called Image, retaining options for Resolution, and 

Adjustments for Brightness and Gamma. 

● Resolution Presets are now grouped into Landscape, Portrait and Custom menus. 
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● Effects, including Bloom Intensity, Bloom Radius and Vignetting Strength has been moved (from the 

Camera tab) to the Image tab, adding an additional option for Vignetting Color. 

● Performance and Quality options (originally under the Settings tab) have been replaced with Lighting 

Presets located on the Lighting tab/menu.  

● Slider settings for Ray Bounces, Indirect Bounces and Shadow Quality along with checkboxes for 

Self Shadows, Global Illumination, Ground Illumination and Focused Caustics (originally under the 

Settings tab) are now located in the Lighting tab under Settings. 

● The Render NURBS checkbox (originally under the Settings tab) is now located solely on the Ribbon 

and in the Render menu. 

● The Motion Blur checkbox (originally under the Settings tab) is now located on the Animation 

Timeline toolbar between the Loop and Preview buttons. 

● In the Render window, options for Region and Passes (originally in separate sections) are now 

included in the Output section. 

● In the Render window, the Quality section has been renamed to Options and now combines setting 

for both Mode and Quality. Open Network Queue (originally under Network) in now located in 

Options. 

● Material Templates UI Update - The Material Templates window is now dockable and provides 

several new features including Search (by template name, material name, and part name) and the 

ability to add an author and description. 

● Render Layers UI Update (Pro) - Render Layers are now easier to work with in KeyShot 6. In the 

Project window Scene tree select a part that you wish to assign to a layer and right-click. You will 

now see an option for Render Layers in the right-click menu. In the flyout menu select Add to New 

Layer or select an existing layer to assign it to. You can also add a selection to a layer by clicking the 

add layer icon under the Properties, Render Layer options or by checking the box of an existing 

layer. When an object is selected a check will identify which layer it is assigned to. By default, all 

objects are assigned to the Default layer. Right-click on any existing layer and choose Select Parts 

by Layer to highlight the parts in the scene tree. 
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